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List of Examples 

This tutorial introduces the main features of AutoPIPE Nozzle using the examples shown below. For more 

information about the functions and operation of AutoPIPE Nozzle, please refer to the online help. 

Example 1: The basic operating procedures of AutoPIPE Nozzle 

Example 2: Anchor load of AutoPIPE 

Example 3: Evaluation example by the level 1 seismic standards of high-pressure gas 

Example 4: Evaluation example by level 2 seismic standards of high-pressure gas  
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Example 1: The basic operating procedures of AutoPIPE Nozzle 

This example describes the basic operation procedure of AutoPIPE Nozzle by using ASME Sec.VIII DIV.1(WRC107) 

option. 

Design condition 

Design Condition of Vessel 

Item Unit Data 

Vessel of type - Cylindrical body 

Material - SB410 equivalent 

Vessel inner diameter mm 2000 

Vessel wall thickness mm 20.0 

Vessel average radius mm 1010 

Internal pressure N/mm2 1.5 

Temperature 
o
C 100 

Allowable stress (at rest) N/mm
2
 103 

Allowable stress (during 

operation) 

N/mm
2
 103 

 

Design conditions of nozzle 

Item Unit Input data 

Type of nozzle - Hollow cylinder nozzle 

Material -  

Nozzle outer diameter mm 267.4 

Nozzle wall thickness mm 12.0 

Nozzle outer radius mm 133.7 

 

Piping load 

Load Unit Own Weight Heat Load 

Radial load P N -1000 -2000 

Circumferential direction shear force VC N 1000 2000 

Longitudinal shear force VL N -1000 -2000 

Circumferential direction moment MC N-m 5000 10000 

Longitudinal direction moment ML N-m 5000 10000 

Torsional moment MT N-m 5000 10000 

Note: Load values are not the actual data in the example. 
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Starting AutoPIPE Nozzle 

Open the Start menu, click All Programs, [Bentley Engineering], [AutoPIPE Nozzle V8i], and choose the 

[AutoPIPE Nozzle V8i]. For Win 8 and higher user, using Window 8 specific features, locate the AutoPIPE 

Nozzle application and open it. 

As AutoPIPE Nozzle starts, you can see a screen similar to the following. 

 

If you are running AutoPIPE Nozzle first time, then first select the “Full License” option. To select Full 

License option, click the File from main menu, a drop down menu will appear select the Authorize 

option. On selecting this option a new dialog box “ AutoPIPE Nozzle License Authorization” will appear. 
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Select the Full License option. 

The full license option is only available on systems that have one following: 

a. AutoPIPE Advanced License 

b. AutoPIPE Nuclear License 

The program will default to demo mode if only AutoPIPE Standard license is available. Check LMT 

(License Management Tool)> License Checkout tab to verify what licenses are available. Again, the 

program will only function if AutoPIPE Advanced / Nuclear license(s) are listed. Otherwise it will revert 

to demo mode. 

Creating new Model 

To create a new model, Click File button from main menu, a drop down menu will appear select New 

from this drop down menu. On selecting this option, a new dialog box invokes. 

 

On clicking <No> button,  a “Save New Model As” dialog box will appear. 
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Navigate to the appropriate folder, enter the name of the model to the "File name" field, and press 

<Save> button. 

Now enter the data for the following tabs. 

Data for System tab 

Click the System tab. In this tab first change the UNIT option from Standard to SI and then enter the 

data as follow 
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Item Unit Input value or selection 

Units  - SI 

Design Code  - DIV I (WRC107) 

Material Library  - ASME1996 VIII DIV I 

Design Pressure  N/mm
2

 1.5 

Design Temperature  ℃ 100 

Ambient Temperature  ℃ 20 

 

Now click the <Y> button to the right of the input field for Design Code, to display the following dialog 

box, and then select the year for calculating the allowable stress values. 
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Data for Shell tab 

Click the Shell tab, and enter the data on the shell as follow: 

 

 

Item Unit Input value or selection 

Shell Type  -  Cylinder  

Shell Thickness  mm  20  

Ambient Stress  N/mm
2

 103  

Design Stress  N/mm
2

 103  

ID  -  Click 

Diameter ID  mm  2000  

Nozzle Axis  -  X  

Shell Axis  -  Z  
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Data for Nozzle tab 

Click the Nozzle tab, and enter the data on the nozzle as follow: 

 

 

Item Unit Input value or selected unit 

Nozzle Type  - Hollow-Pipe 

Nozzle Thickness  mm 12 

Nozzle O.D  mm 267.4 
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Data for Load Tab 
Click the Loads tab, and enter the value <1> for thermal field, and then enter the following data as 

shown below:  

 

Item Unit Input value or selection 

Thermal  -  1  

GR - Fx  N  1000  

Fy  N  1000  

Fz  N  1000  

Mx  N-m  5000  

My  N-m  5000  

Mz  N-m  5000  

T1 – Fx  N  2000  

Fy  N  2000  

Fz  N  2000  

Mx  N-m  10000  

My  N-m  10000  

Mz  N-m  10000  
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Combination Button 

Click on the <Combinations> button in the Loads tab, click on the  <combination> button, Load 

Combinations dialog appears. Click the Load Cases tab, check the GR and T1 (P1 will be checked 

automatically). 

 

Then, click the Auto Combinations tab; you can check the GR and GRP1 + T1 and click <ok> to close the 

dialog. 
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Performing Calculation 

Before running the calculation, save the model first and then select Analyze->Stresses option from 

menu bar. After calculation, you will see a list of maximum stress of each combination in AutoPIPE 

Nozzle window. 
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View Detail stress value 

To view the detailed stress of any combination, select any combination from combination list and 

double click it.  

 

 

Print result 

To view the print preview, click [File]->[Print Preview] command. A dialog box “Printer-Reports” will 

appear. Select the options as needed and press <Ok> button. 

 

 

On Clicking OK a print preview dialog box will appear. 
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To print the result, click the <Print> button. 
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Example2: Import Anchor Loads from AutoPIPE into AutoPIPE Nozzle 

This example describes the interface to transfer the anchor loads calculated in AutoPIPE into AutoPIPE 

Nozzle. 

Open or create a model in AutoPIPE, and select the anchor node of nozzle in model. Now right click on 

the selected anchor, a pop menu will appear, select the [Modify] > [anchor] command.  After selecting 

this option, an “Anchor” dialog will appear, select the anchor type and check the option "Report Anchor 

results to AutoPIPE Nozzle/AutoPIPE Vessel", and close the dialog by pressing the <Ok> button. 

 

Import Loads  

From within AutoPIPE, select [Analysis] option from menu bar of AutoPIPE and select Static option. 

After performing the static analysis, select [File] > [export] > [Nozzle Loads to AutoPIPE Nozzle] to export 

the loads to AutoPIPE Nozzle. The AutoPIPE Nozzle will start automatically, and you can see the 

following dialog in AutoPIPE Nozzle. 

 

Change the “Select Nozzle ID” value to “A00”, Set “Analysis set of number” to (All) , and then press the 

<Ok> button. 
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Subsequently, a dialog for selecting the direction of the nozzle and the Vessel will be display: 

 

Select the direction of the nozzle and the Vessel, and then press the <Ok> button. All of the Anchor 

loads of AutoPIPE will automatically be imported into AutoPIPE Nozzle. This data can be viewed on the 

Load tab. It should be noted that the coordinate system of both AutoPIPE Nozzle and AutoPIPE may be 

different; the program will automatically perform coordinate transformation when the data is imported. 

 

After importing the nozzle load from AutoPIPE continue filling out the other tabs with data as needed 

before running an analysis in AutoPIPE Nozzle. 
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Example3: Level 1 seismic analysis with a cylindrical shell. 

In this example, demonstrate how to perform a “Level 1 seismic analysis with a cylindrical shell”. 

AutoPIPE Nozzle has the ability to import anchor load points that were analyzed by KHK level 1 code in 

AutoPIPE, this example shows a case in which you enter the piping load directly. 

Design condition 

Vessel of design conditions 

Item Unit Data 

Vessel of type _ Cylindrical body 

Material _ SB410 

 

Vessel inner diameter mm 2000 

Vessel wall thickness mm 20.0 

Vessel average radius mm 1010 

Internal pressure N/mm
2

 1.176 

Temperature ℃ 200 

Allowable stress (at rest) N/mm
2

 103 

Allowable stress (during 

operation) 
N/mm

2

 103 

Yield stress (at rest) N/mm
2

 225 

Yield stress (during 

operation) 
N/mm

2

 189 

Design conditions of nozzle 

Item Unit Input data 

Type of nozzle  Hollow cylinder nozzle 

Material  (STPG370-S) 

 

Nozzle outer diameter mm 267.4 

Nozzle wall thickness mm 12.0 

Nozzle outer radius mm 133.7 

Piping load 

Case Fx  Fy  Fz  Mx  My  Mz  

(N)  (N)  (N)  (N-m)  (N-m)  (N-m)  

GR  1000  1000  1000  1000  1000  1000  

T1  2000  2000  2000  2000  2000  2000  

E1  3000  3000  3000  3000  3000  3000  

E2  4000  4000  4000  4000  4000  4000  

E3  5000  5000  5000  5000  5000  5000  

P1  100  100  100  100  100  100  

S1  6000  6000  6000  6000  6000  6000  

S2  7000  7000  7000  7000  7000  7000  

Note: Load values are not the actual data in the example. 
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Input of the System Data 

Click the System tab, and then select the KHK (Level 1) from Design Code field. After changing  the 

Design Code, the following dialog box will display, click <Yes> button. 

 

A “Save Dialog box” will appear,  to save the data click <Yes> button again.  

 

Now select the System tab change the Unit value to SI and then enter the other data as follows: 
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Item Unit Input Value or selection 

Units  - SI 

Design Code  - KHK (level 1) 

Material Library  - KHK 

Design Pressure  N/mm
2

 1.176 

Design Temperature  ℃ 200 

Ambient Temperature  ℃ 20 

Next, press on [File] > [Save As] command, and then save the data for KHK with a new file name. 

Shell input data 

Select the Shell tab and then click <S> button. On clicking this button, a new dialog box “Shell Material” 

will display. 

 

Set  “Section Type” = (Plates), and “Material” = (SB410). Some values will be automatically set on the 

dialog after these selections are made.  Now press the <Ok> button and then enter the other data on 

the Shell tab as follows: 
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Item Unit Input Value and selection 

Shell Type  - Cylinder 

Shell Thickness  mm 20 

Ambient Stress  N/mm
2

 103 (Automatic) 

Design Stress  N/mm
2

 103 (Automatic) 

ID  - （Click） 

Diameter ID  mm 2000 

Nozzle Axis  - X 

Shell Axis  - Y 

Data for Nozzle 

Click the Nozzle tab, and then click <N> button to the right of the Nozzle Material field. On clicking this 

button a “Nozzle Material” dialog box will appear.  
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Select the “Section Type” = (Pipes), select the (STPG370-S) from Material drop down listing and then 

press the <Ok> button. Some values will be automatically set on the dialog after these selections are 

made.  Now press the <Ok> button and then enter the other data on the Nozzle tab as follows: 

Item Unit Input value or selection 

Nozzle Type  - Hollow-Pipe 

Nozzle Thickness  mm 12 

Ambient Stress  N/mm
2

 92 (Automatic) 

Design Stress  N/mm
2

 92 (Automatic) 

Nozzle O.D  mm 267.4 
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Data for Load tab 

Click the Loads tab, and enter the following values in the right-hand column of the load number of 

cases. 

Item Unit Input value or section 

Thermal  -  1  

Seismic  -  3  

Sam  -  2  

Pressure - 1 

 

After entering the above settings, the input field for load case GR, T1, E1, E2, E3, P1, S1, S2 will be 

displayed. Please enter the following data of piping load as shown below:  

 

Then, press the <Combinations> button, a new dialog box “Load Combination” will appear, now click 

the User Combinations tab and press the <KHK L1> button.   
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A dialog will appear, click on the <Yes> button. 

 

The combination for KHK will be automatically set, click on  <Ok> button to close the dialog box. 
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Execution and output result of calculation 

Press [File] / [Save] command, and then save the data to a file. First Save the file and then run “Stress” 

from drop down menu of Analyze for stress Calculation. After the calculation, you will see a list of 

maximum stress of each combination in the lower right area of AutoPIPE Nozzle window. 

 

To view the detailed stress of any combination, select any combination from combination list and 

double click it.  
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Exercise 4: Level 2 seismic standards evaluation of high-pressure gas 

In this example, demonstrate how to perform a “Level 2 seismic standards evaluation of high-pressure 

gas”. AutoPIPE Nozzle has the ability to import anchor load points that were analyzed by KHK level 2 

code in AutoPIPE, this example will then calculate the stress generated at the junction of the shell and 

the nozzle. 

In AutoPIPE, it is necessary to use separate option for KHK level 2 code. 

Design condition 

 

Design Condition of Vessel 

Item Unit Data 

Vessel of type - Spherical shell 

Material -  SPV490  

Vessel inner diameter mm  2000  

Vessel wall thickness mm  15.0  

Vessel average radius mm  1007.5  

Internal pressure N/mm
2

 1.0  

Temperature pressure ℃  40  

Allowable stress 

(at rest) 
N/mm

2

 152  

Allowable stress  

(during operation) 
N/mm

2

 152  

Yield stress 

(at rest) 
N/mm

2

 490  

Yield stress  

(during operation) 
N/mm

2

 490  

Design conditions of nozzle 

Item Unit Input Data 

Type of nozzle - Hollow cylinder nozzle 

Material -  (STPG370-E)  

Nozzle outer diameter mm  457.2  

Nozzle wall thickness mm  9.0  

Nozzle outer radius mm  228.6  

 

AutoPIPE settings 

Open the model in AutoPIPE, click the anchor node of the nozzle, and then click [Modify] > [anchor] 

command. Select the check box "Report Anchor Results to AutoPIPE Nozzle/AutoPIPE Vessel", and then 

close the dialog by pressing the <Ok> button. 
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AutoPIPE’s Anchor dialog 

Click Analysis option from menu bar of AutoPIPE and select static option. After performing the static 

analysis, select [File] > [export] > [Nozzle Loads to AutoPIPE Nozzle] to export this in AutoPIPE Nozzle. 

The AutoPIPE Nozzle will start automatically, and you can see the following dialog in AutoPIPE Nozzle. 

 

Change the “Select Nozzle ID” value to “A00”, Set “Analysis set of number” to (All) , and then press the 

<Ok> button. 

If a non-KHK code was selected in the previous work of AutoPIPE Nozzle, you may receive the following 

dialog box will be displayed. Please go ahead and press the <OK> button. 



27 

 

 

Subsequently, the following dialog will appear, select the Orientation and Nozzle Axis and press <Ok> 

button each time to move to the next step: 

     

Data for System tab 

 Click the System tab.  The Design Code and Material Library have been set automatically.  Now enter 

the other data as follows. 

 

Item Unit Input Value or selection 

Units  - SI 

Design Code  - KHK (level 2) 

Material Library  - KHK 

Design Pressure  N/mm
2

 1.0 

Design Temperature  ℃ 40 

Ambient Temperature  ℃ 20 
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Data for Shell tab 

Click the Shell tab, and then click <S> button to the right of the Shell Material field. On clicking this 

button a “Shell Material” dialog box will appear. 

 

Select the “Section Type” = (Plates), select the (SPV490 T <= T50) from Material drop down listing and 

then press the <Ok> button. Some values will be automatically set on the dialog after these selections 

are made.  Now press the <Ok> button and then enter the other data on the Nozzle tab as follows: 

 

Item Unit Input value or selection 

Shell Type  - Sphere 

Shell Thickness  mm 15 

Ambient Stress  N/mm
2

 152 (Automatic) 

Design Stress  N/mm
2

 152 (Automatic) 

ID  - click 

Diameter ID  mm 2000 

Nozzle Axis  - X 

Shell Axis  - Y 
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Data for Nozzle 

Click the Nozzle tab, and then click <N> button to the right of the Nozzle Material field. On clicking this 

button a “Nozzle Material” dialog box will appear.  

 

Select the “Section Type” = (Pipes), select the (STPG370-E) from Material drop down listing and then 

press the <Ok> button. Some values will be automatically set on the dialog after these selections are 

made.  Now press the <Ok> button and then enter the other data on the Nozzle tab as follows: 

 

Item Unit Input value or selection 

Nozzle Type  -  Hollow-Pipe  

Nozzle Thickness  mm  9  

Ambient Stress  N/mm
2

 78 (Automatic)  

Design Stress  N/mm
2

 78 (Automatic) 

Nozzle O.D  mm  457.2  
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Confirmation of Load Data 

Click the Loads tab to check the load data imported from AutoPIPE. 

 

Execution and result output of calculation 

Press [File] / [Save] command, and then save the data to a file. First Save the file and then run “Stress” 

from drop down menu of Analyze for stress Calculation. After the calculation, you will see a list of 

maximum stress of each combination in the lower right area of AutoPIPE Nozzle window 

 

  



31 

 

To view the detailed stress of any combination, select any combination from combination list and 

double click it.  

The results of the X + Y + DX detailed stress is shown below. 

 

***************** 


